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Audacity B A Quick Overview

File FEdit View Project Generate Effect Analyze Help
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on a new track.
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selected audio.
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recording a track. New
recordings will go on new
tracks.
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Selection Tool

Use to Select, Cut,
Paste, and Delete
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Magnification Tool

Use fo zoom in and out on wave forms.

Click "Mute" to
mute this track

Click "Solo" to
mute all other
tracks

Click the "X" to
delete a track

wave forms Click the tool to select it, then
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Recording

Basic Recording
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PLAY

+ Click to play
audio.

+ Shift+Click to

Loop-Play
selected audio.

RECORD

Click to record audio
on a new track.

PAUSE

Click while recording to take a
break. Then click again to

continue recording on the same

track.

STOP

Click when you are finished
recording a track. New
recordings will go on new
tracks.

. Open Audacity ( Double click onthe

icon onthedesktop or click Start |
Programs | Audecity)

. Test your microphoneevels

(optional).
a. PressRECORD.
b. Spesk into themicrophone

c. If necessary, adjud the
microphonevolume.

d. Press STOP when you have the
correct levels.

e. Delete your practice track

. Click RECORD.
. If youwant to pause while recording

click Pause. To continuerecording on
the same track, click PAUSE.

. When you are donerecording, click

STORP.
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Listening to an existing track while recording a new one

)

3 Audacity
File Edit View Project Generate Effect Analyze Help
New Cir+nN
Open... Ctr+0
Close Clrl+w
2.0 3.0

Save Project As...

Preferences... Cir+P

Exit

. Audacity Preferences

Audio 1/0 ualily] File Formats{ Spectrograms | Directories | Interface Keyboard] Mousel

Playback

Device: |Microsofl Sound Mapper - Output LI

Recording

Device: |Microsoft Sound Mapper - Input LI

Channels: | 1 (Mona) LI

< IV Play other tracks while recording new one

IQ Audacity

File Edit View Project Generate Effect Analy

New Cirl+N

Open... Ctr+O

Close Crl+w

| 2.
Save Project As... I
.l o n | i

PLAY RECORD PAUSE STOP
+ Click to play  Click to record audio  Click while recording to take a Click when you are finished
audio. on a new track. break. Then click again to recording a track. New
+ Shift+Click to continue recording on the same  recordings will go on new
Loop-Play track. tracks.
selected audio.

1. Open Audaity ( Doubleclick onthe
icon onthedesktop or click Start |
Programs | Audecity)

2. Check the preferences to make sure
Audecity can play and record at the same
time.

a. Click on File and choo®
Preferences.

b. Click the Audio 1/0 tab.

c. Make sure that there is a check
next to the box (Play other tracks while
recording anew oneO

3. Click Fileand choos Open

4. Browseto findyourlisteningfile and
then click open.

5. Click RECORD to listen to the
origind track and record your own voice
onanew track.
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Exporting & Saving
When you finish working with your audecity tracks, you have several optionsfor saving yourfiles. You
can save your files as an Audecity Project, or export them in .wav, .mp3, or .oggformats. Here(3 an

oveview of these options

File Format Audio Qudity File Size Compaible with | Best format for
Filesyou plan to
Audecity Project Excellent BIG! Only Audaity! | continueeditingin
Audeity.
.wav format Excellent BIG! Most media AUdl.O CDs ngh
players Qudity Recordings
.mp3 Good Small Most media Web audio
players
Filesyou have
: finished editing,
.0gg Good Small Only Audecity listen to only in
Audeity

Mog of thetime, youwill save yourfilesin .wav or .mp3format. Audecity and .oggformats are only
goodoptionsif you are planning on doing further editing or if you knowthefileswill only be used with

Audeaity.
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Exporting as .wav
Y ou can choo% to export al of thetracksin your project, asingle track, or any part of atrack.

Exporting all tracks together (.wav)

If you have more than onetrack in your project this will Gnix downOyour tracks. In other words the
audio on each track will becombined, or mixed into asingle track.

File Edit View Project Generate Effect Ar 1. Click File and choo® Export as WAV
MNew Cirl+N
ik Crio 2. Choo® adegtinaion and aname for yourfile,
Close Cri+w L
Save Project Crl+s - .
Save Project 4s... 3. Click OK.
Export As WAV, “

Exporting a single track, or a part of a track (\wav)

Audeity alows youto export any pat of arecording asa.wav file. Thisisussful if you want to break
up alongrecordinginto several smaller files.

D19 1. Select the part of thetrack tha you want to
File Egit View Project Generate Effect Analyze Help : expon‘_ If youare Savn‘]g agng'e trmk’ select
= o) n ) D = O thetrack tha youwant to save.
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Dc19 2. Click File and choo® Expart Selection as
File Edit View Project Gererate Effect An: WAV

New Ctrl+N

S cr+o 3. Choos a degtinaion and aname for your

Close Chri+wy - .

Save Project Ctrl+s % fil €.

Save Project As...

Export As WAVY... 4. Click OK.

Export Selection As WaV...

Export As MP3...
Export Selection As MP3...
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Exporting as .mp3

Exportingin .mp3format isvery similar to exporting in .wav format. Y ou can choo% to expart all of the
tracks in your project, asingle track, or any pat of atrack.

Exporting all tracks together (.mp3)

If you have more than onetrack in your project this will Gnix downOyour tracks. In other words the
audio on each track will becombined, or mixed into a single track.

File Edit View Project Generate Effect A

New Ctrl+N
Open... Ctr+0

Close crivw L
Save Project Ctr+S -
Save Project As...

Export &s Wa\... *
Export As MP3...

'Edit the ID3 tags for the ... |4
Format:

(o |D3v1 [more compatible)
" |D3v2 [more flexible)

Title: |

Artist: |

Album: |

Track Number: | Year |

Genre: I LI

Comments: |

Cancel ‘ 0K |

1. Click File and choos Expart as MP3
2. Choos adestinaion and aname for yourfile.

3. Click OK.

4. For theformat, we usudly choos ID3v1 (more compdtible).
We have not had any problems with either format.

5. Enter therecording information (optiond).

6. Click GKO(nate - You must click OQK.Oln some versionsof
Audaity, clicking GCancel Oon this screen causes problems with
theexport).

7. Close Audaity (you don®need to save your audio in audecity
format unless you want a high-qudity back-up copy or need to
do further editing).
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Exporting a single track, or a part of atrack (.mp3)

Audaity alows youto export any pat of arecording as an .mp3file. Thisisuseful if youwant to break

up alongrecordinginto several smaller files.

&c19
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File Edit Yiew Project Generate Effect A
New Cirl+N
Open... Ctrl+O
Close Cirl+w L
Save Project Ctr+S :
Save Project &s...
Export As WAVY...
Export Selection As WAV...
Export As MP3...
Export Selection As MP3...
Fxhnrt 4s Onn Ynrhis. ..

Edit the ID3 tags for the ...
Format:
(o |D3v1 [more compatible)
" 1D3v2 [more flexible)
Title: |
Artist: I
Album: |
Track Number: | Year [
Genre: [ L‘
Comments: |
Cancel | oK |

1. Select thepart of thetrack tha you want to
export. If youare saving asingle track, select
theentire track tha youwant to save.

2. Click File and choos Export Selection as
MP3

3. Choo% adestinaion and aname for your
file.

4. Click OK.

4. For theformat, we usudly choos ID3v1
(more compaible). We have not had any
problems with either format.

5. Enter therecording information (optiond).

6. Click K O(nate - You must click OK.O
In some versionsof Audacity, clicking
GCancel Oon this screen causes problems with
theexport).

7. Close Audaity (you don®need to save
your audio in audecity format unlessyou
want a high-qudity back-up copy or need to
do further editing).
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Basic Editing

Deleting audio

1. Click and drag to select the 10 o0
audio tha you want to ddete. X[test v[ 10

Mono, 32000Hz
32-bit float
2. Press backspace or delete 10 iz | | Sob

ddete this section of audio " gt

L &) R

0.5

-0.5
-1.0

The Edit Menu

1. Click and drag to select theaudio tha you
want to modify.

2. Select an option from the Edit menu.

Edit Menu Optionsindude

¥ Cut, Copy, and Paste

¥ Trim (ddete all audio except the
selection)

¥y Delete (the selected audio)

¥y  Silence (replace the selected audio with
silence)

¥ Duplicate (copy the selected audio to a
new track)

The Effect Menu

1. Click and drag to select theaudio tha you want to

modify.
2. Select an optionfrom the Effect menu.

Effect Menu Optionsindude

thegray ba shows
tha this audio has
been selected

File Edit View Project Generate Effect aAnalyze Help

[
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-15
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32-
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Undo
Redo

Cut
Copy
Trim

Delete
Silence

Split
Duplicate

Select...

Ctri+z
Ctri+y

Cri+X
Ctr+C
Cri+T

Ctr+K
Ciri+L

Ctr+D

Find Zero Crossings Z

Selection Save
Selection Restore

Effect analyze Help

¥ Amplify (increases or reduces the volume of selected

audio)

¥ Changespeed (increases or reduces thelength of time

for selected audio)

¥ Equdization (changes volume levels for low, mid,

and high ranges of selected out)

¥y Fadeln/Out (gradudly inareases/reduces thevolume

level of selected audio)

Repeat

Amplify...
BassBoost...
Change Pitch...

Change Speed...
Change Tempo...

Compressor...
Echo...
Equalization...
Fade In

Fade Out

FFT Filter...
Invert

Noise Removal...
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Appendices

A. Installing Audacity

1. Go to http://audacity.sourceforgenet/

2. Click Download Audecity

3. Click thelink to download the mog recent version

4. After thedownload finishes, find theingaller file and open it.
5. Follow theingallationingructions

6. You@e doné

B. Downloading & Installing the MP3 encoder (lame.lib)

Downloading the encoder

In order to create .mp3files with Audacity, you@ need to download a special encoder called lame.lib.
Theencode isafreefile tha allows audecity to create MP3s

for Windows

1. GototheLAME download pagefor Windows - hitp://mitiok.free.fr/

2. Click onany link from thelist of identical "lame-3.96.1" links

3. When you have finished downloading LAME, unzp it and save thefile lame_enc.dll anywhere on
your computer. It isagoodideato saveit in the Audacity folder. Be sure to remembe where you
save thefile.

for Mac OS 9 or X

1. GototheLAME download pagefor Macintosh - http://spaghéticodeorg/lame/

2. Download theversion of LameLib for your opeating system.

3. When you have finished downloading, use Stuffit Expande to extract thefiles. (Thismay happen
automatically.)

4. Savethefilecaled "LameLib" anywhere onyourcomputer. It isagoodideato ingall it inthe
Audecity folder. Be sure to remember where you save thefile.

Installing the MP3 encoder
After downloadingtheencode, indall it by exporting any audio file asan MP3 in Audecity. Y ou will
only haveto indall theencodea once.

m 1. Open Audaity ( Double click ontheicon onthe desktop or
click Start | Programs | Audecity)

Open Audeity
GBI it Vew Projst cenas Efect 4 2. Press QRecordOand then CBtopQto record alittle bit of
o o | audio.
Sremoset cries 3. Click File and choo Expart as MP3.
4. Audaity will ask youto find thelamellib encode file.
_ bt Browse to find this file onyour hard drive and then click
prt Slcton OK.

5. Choos adestinaion and aname for yourfile.

6. Enter thefileinformationand then cljck OK.

The MP3 encode isnowindalled. You@e ready to export MP3
files!
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